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Analysing your survey data - advanced 

Exercise sheet
Your analysis goals
· What questions do you have from the survey data responses? 
· What are you interested in exploring? 
· What correlations might you want to investigate? 

List 5 things you’d like to find out.

Exercise 1 – Pivot Tables & Charts refresher
*Top tip – make a copy of your survey results Excel file before starting your analysis so you have the raw data to go back to if you need it.
Part 1
1. Click anywhere in the data in the Survey results sheet and change to a Table (Insert tab, Table) and name it “Surveyresults” (rename in the top left of your screen)
2. Now create a Pivot table (Insert tab, Pivot table) and rename it Surveypivot (top left) and also rename the Sheet (double click on sheet tab at the bottom and rename Survey pivot)
3. Now select the PivotTable fields PrisonID, Enjoyed the sessions, adding PrisonID to the Values quadrant (bottom right), and the Prisons to the row and Enjoyed the sessions to the column quadrant.
4. Now add Prisons in the PivotTable fields list. Change the layout to see different views – first drag Prisons so sits above Enjoyed the sessions field in the row quadrant. Now drag Prisons to the column quadrant
5. What does the data tell you?  What might you want to investigate further?  Add other fields to the PivotTable to delve into your data some more.
Part 2
6. Now simplify by just selecting the 3 fields above – this time with Prisons in the row quadrant and Enjoyed the sessions in the column quadrant
7. Create a PivotChart (click in PivotTable data, go to PivotTable Analyse tab and then select Pivot Chart, going with the suggested chart.
8. Are there any issues when comparing prisons? What problem can you see?
9. You could convert to percentages – go to the Count of Prison ID (bottom right quadrant) and click on the down arrow to open up the Value field settings box.  Select the Show Values As tab and choose % of Row Total option from the drop down menu.
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10. Now click on the Chart and the Design tab and select to Change chart type. Choose the Stacked bar chart 
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*Top tip – if you are pasting charts into reports e.g. in Word, paste as an image, otherwise the chart will change when you are making changes to your PivotChart (otherwise it is linked by default!)

Extra exercise – Looking at change
11. In the Survey results sheet, add a calculation in the Change column (Column I) to show the change in Optimism scores =H2–G2 (the formula should automatically copy down)
12. Create a new PivotTable and call it Changepivot
13. Select Prison ID, Prison and Change in the PivotTable fields and drag Prison to the row and Change to the column quadrant, with Count Prison ID in the Values quadrant
14. Now filter the Pivot Table to just show the 4 prisons beginning with B
15. Which prison looks to have achieved the best results in terms of the Change in optimism?  Which prison has comparatively not done so well?



Exercise 2 – Analysing multi select multiple choice answers
Part 1 – Total Row
1. Go to the Multiple Choice 1 sheet and click in the Table and add a Total row – Go to the Table design tab, and in the Table style group (centre of the menu) tick the Total row option
2. Now scroll down and under the Saxophone click on the Down arrow and choose Count.
3. Now copy this formula across to the neighbouring cells
4. How many people have prior experience of playing the guitar?  (Answer 55)

Part 2 – Text Filter (demo)
1. Go to the Multiple choice 2 sheet and use Text filter to filter on a particular instrument (click on the down arrow in the Column header and then type in the instrument name in the Text filter box)
2. Check you get the same answer for guitar

Part 3 – Count If (demo)
1. Go to the Multiple choice 2 sheet and look for the summary table in columns E & F
2. Add the Countif formula in the cell next to each instrument to return the count of numbers of each one. E.g. in cell F3 add the formula =Countif(select column C, “*Bass*”) and repeat for each instrument.
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*Top tip – copy down the formula and manually overwrite for each instrument
	Instrument
	Number

	Bass
	34

	Drums
	79

	Guitar
	55

	Electric Keyboard
	105



3. Now select this summary table and create a chart to visualise this data (Select data and go to the Insert tab, Recommended charts (towards the centre of the menu bar)



Exercise 3 – Unpivot data method 1 (tabular)
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1. In the Multiple Choice 1 sheet, click in the data and make the data into a Table (Insert tab, Table or shortcut Ctrl +T).  Name it “Multiplechoice1” 
2. Open the Power Query Editor (Data tab, and in the Get & Transform Data Group select the From Table/Range button)
3. Unpivot the data (Highlight the columns to unpivot using the shift key-Transform tab-Unpivot data button)
4. Remove the Attributes column (Right mouse click – Remove)
5. Rename the Values column “Instrument” (Right mouse click-Rename)
6. Upload & Close the query (Home tab – Upload and Close)
7. Rename the results worksheet “Unpivoted data 1”

Exercise 4 - Unpivot data – method 2 (delimited)
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1. Go to the Multiple Choice 2 worksheet
2. Rename the Table “Unpivotdata2”
3. Open the Power Query Editor (Data tab – From Table/Range button)
4. Split the data in the column (Home tab- Select column - Split Column button-select a semi colon as the delineator)
5. Unpivot the data (Highlight the columns to unpivot using the shift key-Transform tab-Unpivot data button)
6. Remove the Attributes column (Right mouse click – Remove)
7. Rename the Values column “Instrument” (Right mouse click-Rename)
8. Filter out the blank rows (Filter on Values column – deselect blanks)
9. Upload & Close the Query (Home tab – Upload and Close)
10. Rename the results worksheet “Unpivoted data 2”

Exercise 5 – Coding open text responses 
1. In the Survey results sheet, Unhide Column N (highlight columns M & O either side, right click and select Unhide) to reveal the pre prepped coding
2. Open the Power Query Editor (Data tab – Get & Transform data tab and Table/Range button)
3. Select the columns to include in the query results as: Prison ID, Prison, What do you think would improve the sessions?, Improvement areas (Home tab – Choose Columns – Select from the list)
4. Split the data in the Improvement Area column (Transform tab -Split Column button-By Number of characters 1 checking that Repeatedly is ticked too)
5. Unpivot the data (Highlight the columns to unpivot - Transform tab - Unpivot data button)
6. Remove the Attributes column (Right mouse click in the column header – Remove)
7. Rename the Values column “Improvement areas” (Right mouse click in the column header – Rename)
8. Upload & Close the Query (Home tab – Upload and Close)
9. Use Find & Replace to replace the number codes with text (copy the text box from the survey sheet to make it quicker)  (Or you could stick with the number for now and rename in the Pivot table created below)

Optional - Creating a pivot chart 
1. Create a Pivot table in the Unpivoted data 3 worksheet (Click in the Table, Insert menu – Pivot table)
2. Rename the new worksheet “Improvement areas”
3. Add Improvement Area to the Rows & Prison ID to the Values field areas
4. Add What do you think would Improve the sessions? To the Rows under Improvement Areas
5. Use the + and – on the Row to show/hide rows
6. Sort the Pivot chart by number of people per row (Arrow next to row column, More sort options – Descending – Count of Prison ID)
7. Add a pie chart (Click in the Pivot Table, PivotTable Analyse menu-Pivot Chart)
8. Format the pie chart to show percentages (Click on pie chart, Design tab-select a format with percentages)
9. Remove the field Count of Prison ID (Right click on the field in the chart – Remove)
10. Hide all field buttons (Right click on a field in the chart – Select Hide All Field buttons)
11. Rename the chart (Double click into the Title to type in a new heading)
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Exercise 6 – Xlookup
This formula searches a range or an array for a match and returns the corresponding item from a second range or array. By default an exact match is used.

1. In the Summary sheet, use Xlookup to bring in data for the respective prisons from the Prison info sheet into the Number of mentors column. 
1. Follow the Xlookup format below
  [image: ]

For this scenario you’ll need to use =XLOOKUP(A4, 'Prison info'!A:A,'Prison info'!F:F) and then copy the formulae down.



Exercise 6 - Bringing data together with Power Query

[bookmark: _Toc213248147]Creating queries
1. Click on the table
2. On the data tab select From Table/range
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3. Check the query has the prison name 
4. On the home tab, select Close and Load to
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5. Under the Import data options select Only Create Connection
6. Click on OK
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7. Repeat for the other 3 Prisons


[bookmark: _Toc213248148]Appending queries
1. Open the Query editor on the Data tab by going to Get Data and selecting Launch Power Query Editor.
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2. On the Home tab, select the option Append Queries as New 
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3. Select the 4 Prison queries by clicking on them  and then on Add>> so that all 3 queries are in the Tables to append box
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4. Click on OK
5. A new query will appear on the left called Append1[image: A screenshot of a computer
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6. Double click on Append 1 or right click and select rename, and rename it to All participants
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7. On the Home tab click on the Close & Load button
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8. You should now have a new sheet called All participants in your workbook
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[bookmark: _Toc213248149]Adding source data and refreshing queries
1. Add a row of data for a new participant to any of the 3 prison tables
2. Refresh the query either individually by clicking on the refresh icon next to the query name 
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Or by clicking on Refresh all on the Data tab
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A HMP_Manchester
Hazel Bramble HMP Belmarsh HMP 1235 null 23/07/1966 00:00:00 n

[ HMP_Wormwood_Sc...

Al participants|

1
2
3 Holly Thorne HMP Belmarsh HMP 1236 null 14/11/1967 00:00:00 n
4 Willow Moss HMP Belmarsh HMP 1237 null 30/04/1968 00:00:00 n
5

Fern Cotter HMP Belmarsh HMP 1238 null 02/12/1969 00:00:00 n
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Mahogany Shaw  HMP Brixton HMP 1252 30321 No musical experience I
‘Sakura Inoue HMP Brixton HMP 1253 31006 No musical experience
Lotus Mehra HMP Brixton HMP 1254 31165 Plays a musical instrument E
Bamboo Tanaka  HMP Brixton HMP 1255 31640 No musical experience  V
Maranta Leong HMP Brixton HMP 1256 32118 No musical experience E
PlumeriaAnand  HMP Brixton HMP 1257 32205 Not recorded v
Ginger Kiri HMP Brixton HMP 1258 32795 Plays a musical instrument E
‘Ash Rowan HMP Brixton HMP 1284 28960 Plavs a musical instrument
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a
1 ison number K2 Eth al experience | Skills learnt Quenesietionnectiony v &
2 [RowanAlder _ HMP Belmarsh HMP 1234 07/02/1965 Plays a musical instrum Focusing on a task, Working as a team, Communicating itk 2 Agree 1 Really enjoyed 2 3 5
3 |HazelBramble HMP Belmarsh HMP 1235 23/07/1966 Plays a musical instrum Working towards a goal, Improving ability through practice 3 Disagree 3Didn't enjoy 3 3 Queries | Comnections
4 |HollyThome _ HMP Belmarsh HMP 1236 1411171967 No musical experience Working as a team, Communicating with others 2Agree 2Enjoyed 2 2 5 queries
5 |WillowMoss  HMP Belmarsh HMP 1237 30/04/1968 Plays a musical instrum Working as a team, Communicating with others 1 Strongly agree 3Didn'tenjoy 5 6
6 |Fern Cotter HMP Belmarsh HMP 1238 02/12/1969 No musical experience Focusing on a task, Working as a team, Communicating witt 1 Strongly agree 2Enjoyed 4 5 I HMP_Belmarsh
7 [ivy Brook HMP Belmarsh HMP 1239 19/09/1970 No musical experience Building relationship with mentor, Working towards a goal 2 Agree 4Really didn't enjoy 2 7 ‘Connection only.
8 |LaurelFenn _ HMP Belmarsh HMP 1240 03/03/1971 Plays a musical instrum Working towards a goal, Communicating with others 1 Strongly agree 3Didn'tenjoy 2 2 VP Brivion
9 |Poppy Heather _ HMP Belmarsh HMP 1241 26/06/1972 Plays a musical instrum Improving ability through practice, Building relationship it 1 Strongly agree 3Didn'tenjoy 6 7 -
10 |Clover Reed HMP Belmarsh HMP 1242 11/01/1973 Plays a musical instrum Improving ability through practice, Communicating with oth 1 Strongly agree. 2Enjoyed 4 4 Connection only.
11 [Sorrel Ash HMP Belmarsh HMP 1243 08/10/1974 No musical experience Building relationship with mentor, Working towards a goal 2 Agree 1 Really enjoyed 4 2 T HMP_Manchester
12 |Primrose Tilling_ HMP Belmarsh HMP 1244 25/05/1975 No musical experience_Improving ability through practice, Building relationship witt 3 Disagree 2Enjoyed 3 3 Connection anly.
13 [Foxglove Banner HMP Belmarsh HMP 1245 15/08/1976 Plays a musical instrum Building relationship with mentor, Working towards a goal 3 Disagree 2Enjoyed 6 6 _
14 |Bluebell Harrow HMP Belmarsh HMP 1247 06/11/1977 No musical experience Improving ability through practice, Communicating with oth 2 Agree. 2 Enjoyed 3 4 TZ HMP_Wormwood_Scrubs
15 [BaobabMoyo _ HMP Belmarsh HMP 1247 18/02/1978 No musical experience Improving ability through practice, Communicating with oth 3 Disagree 2Enjoyed 6 B ‘Connection only.
16 Tamarind Ellis __ HMP Belmarsh HMP 1248 09/07/1979 Plays a musical instrum Communicating with others, Working towards a goal 2Agree 2Enjoyed 4 5
17 [BirchTansy  HMP Belmarsh HMP 1314 29/04/1959 Plays a musical instrum Working as a team, Communicating with others 2Agree 4Really didn't enjoy 5 9 _
18 |GingerVale _ HMP Belmarsh HMP 1315 12/06/1999 No musical experience Working as a team, Communicating with others 2Agree 2Enjoyed 2 2
19 [Marigold Finch _ HMP Belmarsh HMP 1316 18/12/1986 No musical experience Focusing on a task, Working as a team, Communicating witf 1 Strongly agree 2Enjoyed 4 5
20 |[Flamboyant Patel HMP Belmarsh HMP 1317 05/11/1965 No musical experience Building relationship with mentor, Working towards a goal 2 Agree 4Really didn't enjoy 2 7
21 BaobabMoyo _ HMP Belmarsh HMP 1318 02/01/2002 No musical experience Building relationship with mentor, Working towards a goal 2 Agree 1 Really enjoyed 4 2
22 [Hawthorn Everly HMP Belmarsh HMP 1319 21/09/1972 No musical experience_Improving ability through practice, Building relationship witt 3 Disagree 2Enjoyed 3 3
23 [Sprig Leong HMP Belmarsh HMP 1320 30/07/2007 No musical experience_Improving ability through practice, Communicating with oth 2 Agree 2Enjoyed 3 4
24 [Taro Hollis HMP Belmarsh HMP 1321 19/04/1964 No musical experience_Improving ability through practice, Communicating with oth 3 Disagree 2Enjoyed 6 8
25 |Cassava Rivera HMP Belmarsh HMP 1322 04/10/1983 No musical experience Working as a team, Communicating with others 2Agree 2Enjoyed 6 7
26 [Yam Dumas __ HMP Belmarsh HMP 1323 11/02/1991 No musical experience Working towards a goal, Improving ability through practice 2 Agree 3Didn'tenjoy 2 2
27 [Kapok Anand __ HMP Belmarsh HMP 1324 09/03/1976 No musical experience_Improving ability through practice, Building relationship it 1 Strongly agree 2Enjoyed 9 8
28 [Mahogany Silva_ HMP Belmarsh HMP 1325 24/06/2000 No musical experience Working towards a goal, Communicating with others 2Agree 4Really didn't enjoy 7 9
29 |Jacaranda Ndlovi HMP Belmarsh HMP 1326 27/01/1962 No musical experience Working towards a goal, Improving ability through practice 3 Disagree 4Really didn't enjoy 2 3
30 [Cacao Mendoza HMP Belmarsh HMP 1327 15/08/1973 No musical experience Building relationship with mentor, Working towards a goal 2 Agree 2Enjoyed 5 9
31 Camphor Kato _ HMP Belmarsh HMP 1334 27/05/1965 No musical experience Focusing on a task, Working as a team, Communicating witf 1 Strongly agree 2Enjoyed 4 5
32 [SoursopJay _ HMP Belmarsh HMP 1335 141101972 No musical experience Building relationship with mentor, Working towards a goal 2 Agree 4Really didn't enjoy 2 7
33 JujuElwood _ HMP Belmarsh HMP 1336 02/01/1989 No musical experience Building relationship with mentor, Working towards a goal 2 Agree 1 Really enjoyed 4 2
34 ChervilKazi_ HMP Belmarsh HMP 1337 31/07/1995 No musical experience_Improving ability through practice, Building relationship witt 3 Disagree 2Enjoyed 3 3
35 [Mangrove Lowe HMP Belmarsh HMP 1338 06/03/2001 No musical experience_Improving ability through practice, Communicating with oth 2 Agree 2Enjoyed 3 4
36 |Aloe Menon _ HMP Belmarsh HMP 1339 18/11/1980 No musical experience_Improving ability through practice, Communicating with oth 3 Disagree 2Enjoyed 6 8
37 |Calen Buckthomn HMP Belmarsh HMP 1340 25/04/1968 No musical experience Working as a team, Communicating with others 2Agree 2Enjoyed 6 7
38 [DracoKiran __ HMP Belmarsh HMP 1341 10/09/1990 No musical experience Working towards a goal, Improving ability through practice 2 Agree 3Didn'tenjoy 2 2
39 [PandanWatts _ HMP Belmarsh HMP 1342 07/02/1997 No musical experience_Improving ability through practice, Building relationship it 1 Strongly agree 2Enjoyed 9 8
40 |Scot Darcy HMP Belmarsh HMP 1343 20/12/1961 No musical experience Working towards a goal, Communicating with others 2Agree 4Really didn't enjoy 7 9
Hornbeam Zane HMP Belmarsh HMP 1344 03/06/1986 No musical experience Working towards a goal, Improving ability through practice 3 Disagree 4Really didn't enjoy 2 3
‘Sweetgum Otienc HMP Belmarsh HMP 1345 22/08/1967 No musical experience Building relationship with mentor, Working towards a goal 2 Agree 2Enjoyed 5 9
Sloane Yates _ HMP Belmarsh HMP 1346 11/01/2003 No musical experience Building relationship with mentor, Working towards a goal 1 Strongly agree 4Really didn't enjoy 2 6
CressHibbert _ HMP Belmarsh HMP 1347 09/10/1979 No musical experience Working as a team, Communicating with others 2Agree 3Didn'tenjoy 3 3
Celery Dip HMP Belmarsh HMP 1500
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1 Prison number [ Ethni

2 HMP Belmarsh HMP 1234 07/02/1965

3 |HazelBramble _HMP Belmarsh HMP 1235 23/07/1966

4 [HollyThome _HMP Belmarsh HMP 1236 1411171967 No musical experience Working as a team, Communicating

5 |WillowMoss  HMP Belmarsh HMP 1237 30/04/1968 Plays a musical instrum Working as a team, Communicating with others 1 Strongly agr

6 |Fern Cotter HMP Belmarsh HMP 1238 02/12/1969 No musical experience Focusing on a task, Working as a team, Communicating witr 1 Strongly agr

= Tiow Broak P LMD 1920 10/00/1970 No misdcal axneriance |Ruilding ralationshin with mantor Working towards 2 goal | 12 Agrae.




